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1 Introduction

This small tutorial explains how to do a simple refinement of a small-molecule structure with MoPro (Guil-
lot, B., Viry, L., Guillot, R., Lecomte, C. & Jelsch, C. (2001). J. Appl. Cryst. 34, 214-223; Jelsch, C.,
Guillot, B., Lagoutte, A. & Lecomte, C. (2005). J. Appl. Cryst. 38, 38-54) using either a spherical atomic
model or a multipolar atom model transferred from an experimental electron-density database. A link for
downloading the program with test data can be found at the SECIPROCS site. Note that you have to fill in
a registration form if you want to download MoPro for the first time in order to obtain a password.

2 Refinement using the Spherical Atom Model

The starting point are the cif-file gz1.cif, the hkl-file gz1.hkl, and the electron-density database file EL-
MAN2.TXT. You can put the latter file anywhere you want, but for practical purposes we just put it in the
data folder. The starting point is thus like this:
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Start the MoPro interface (normally by double-clicking on the executable jar-file MoProGUI-1105.jar for
windows systems), and if the program asks you for a working directory, select the directory of the gz1 files.
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If you have not done so before, start by defining the location of a number of executable files:
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The first thing to do is to convert the cif-file (the starting point of the refinement) to a format that is
readable for MoPro. For that go to File — Import2MoPro, select the file gz1.cif and a dos-box opens:

2y =10l x|
mopro initialization file:
“~~MARIUS“Profdata~wvdlee~Application Data“mopro~mopro.ini

Working Directory (indicated in ‘mopro.ini’ file by FILE DIR>:

H:“projects reciprocs™aussois gz_trfs

Import coordinates to MoPro format

working directory: H:=“projects reciprocshaussois ge_trf
INFUT FILE := H:wprojectssreciprocs-aussoissg=_trf gzl.cif
Convert CIF —> MoFro

NMAME OF OUTPUT MOPRO MOLECULAR FILE 7 [mopro_B@.parl

Change the default name mopro_00.par to gz1_00.par and then press <return> for all other questions. You
return in the main MoPro window and now you can input your molecular structure in the upper part of the
right pane. Select as well the hkl file and then the MoPro window should look like this:
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In MoPro it is important to specify the exact format of the hkl file, since not only Shelx-type HKLF4 are
read. To specify the format of the file, go to Add in the left pane and and add after the selected item an
"Options tab’:
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Check X-ray, hkl input file and Format. Enter in the format box *(314,12X,F12.2,F10.2,2X)’ without the
quotes. This is the Fortran-style format of the reflection lines in the reflection file. If you work with
your own files, you need to change this name for sure. A typical HKLF4 file will give most probably
’(314,F8.0,F8.0)".

Now the constraints and/or restraints files have to be prepared. Add a Preparation tab, as was done for
the *Options’ tab, and check the H-X Bond Distances and Riding Thermal Uiso check boxes. In order to
be more flexible you should add as well the angles constraints. The constraints file is a text file that can be
edited. Note that the constraints are equivalent to a riding motion of the protons on their parent atoms after
resetting the distances to the values given in the constraint file. Note also that the parent-hydrogen distance
in MoPro is set at the neutron distance (approximately 1.09 A for a CH and 0.97 A for an OH). This is less
logical for a classical spherical atom model refinement but should absolutely be done for a refinement after
transfer of the multipolar data base. The MoPro window should look now like this:
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This will create a file called "CONSTRAINT” in the working directory, when the green ’Run MoPro’ in the
left lower corner of the MoPro screen is pressed. To have output on your screen, answer Yes on the question
whether the mopro.out file file needs to be scanned during execution. Press ok in the MoPro log window
and you can check the contents in the MoPro Output File window. There is one harmless warning.
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WNMARTUS\ Profdataivdleeldpplication Data\uoproinopro. ini

Vorking Directory [indicated in 'mopre.ini' file by FILE
DIR):

H: /projects/reciprocs/aussois/gz_trf/

opening mopro input commends file:

H: /projects/reciprocs/aussois/gz_trf/mopro.inp

HoPro job finished

You can now remove the Preparations tab by selecting it in the left pane and clicking on Remove in the
left lower part of the window. Go back to the Files tab, and browse for the CONSTRAIN file that you have
just created:
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Add a Refinement tab to the list; take care to add it affer the Options tab. Check the refinement of the
scale factor and also increase the number of refinement cycles to let’s say 5. The latter modification can be
done in the lower part of the window:
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Run MoPro, and answer Yes on the question whether the existing mopro.inp file should be overwritten.
The result shows that a new gz1_01.par is written and the refinement converges nicely:
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B roPro Log

H:/projects/reciprocs/suseois/ge_trf/uopro. inp
cycle

loop VRZ(F) maxShift/Sigma Nobs  Nvar
/ 3.7535 5.7880 1510 1
/ 3.7125 0.0000 1510 1
/ 3.7125 0.0000 1510 1
/ 3.7125 0.0000 1510 1
/ 3.7125 0.0000 1510 1

MoPro job finished
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Go back to the MoPro Input File tab and therein the Files tab. For the new refinement we should select
the new molecular par file. This can be simply selected by pressing next:
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Now we want to refine the positional coordinates and the thermal factors, but not for the hydrogen atoms.
Go to the Refinement tab and check xyz, thermal parameters, and the exclude checkbox for Hydrogens. If
you want to let the hydrogen atoms ride on their parent atoms, then you should leave the exclude hydrogen
check box unchecked. For the purpose of this tutorial we leave it checked.
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Press the green ’Run MoPro’ button and let the refinement go. You should have at the end an R-factor
of 3.2917.

A MoProGUI for Windows XP
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Topro.out ; Cycle o 2 =
FILE PARA gz1_01|% Frale, deriwatives and normal matrix : 0.1250 s
FILE DATA gzt hkl Minimization (CG/LS) 0.0000 5
FILE TAEL C\difi Cyele W0 3
FILEWAYE Cidifft Feale, derivatives and normal matrix 0.1250 s
FILE AWOM CAdi) Finimization (CG/LE) 0.0000 5
FILE CONE COMSE|
RADI KRAY i Cyole Ho 4
HILI | FORMAT (31 Feale, derivatives and normal matrix : 0.1084 5
SELE SCANYZ UL & Minimization (CG/LS] 0.0156 s
o~ REFILE & i Cyele Ho &
Feale, derivatives and normal natrix : 0.1250 5
Minimization |CG/L3) 0.0158 5
-- End of MoFro job : 2070972011 13:59:11
- -~ Total CPU time needed : 0nwin  0.8594 s
--- Writing nev output £ile : mopro DOZ.out
Last molecular file : gzl 02.par
[l i vl ]
-
4305 4305
wRIF
i
wRAL
gaf F
gof_Fiee
4 R
Scan mopro.out i
. 2 3 4 K
MoP 0 [ 0 0

H: /projects/reciprocs/sussois/gz_trf/mopro.inp
cycle loop WRZ({F) mexShift/Simma Nobs
/5 7 3.7128 £.0904 1510
2/ L2913 L5276 1510
3/
4/
5/

5
5
5
5

MoPro job finished

Ofcourse you can try to model better the hydrogen positions and fine-tune other options, and you should
for sure inspect the difference Fourier maps with the MoProViewer. For that you need at least create the
proper files by adding an *Output’ tab to the list of tabs in the upper left pane. In order to have a cif file
click the cif-checkbox and if you need a Fourier file that can be visualized with MoProViewer you need to
check the FOUR box.
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3 Refinement using the Multipolar Atom Model transferred from a
database

For this we need to define the database by adding a 'manual commands’ tab. Enter the commands displayed
in the below figure:

[ MoProGUI for Windows XP - H:'projects’, reciprocs’, aussois g
ile Edit MoPro WMoPro MoProViewer Help

MoPro Input File x

=10l x|

10pro.inp Wanual Commands
Files Enter your commands here:
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Refinernent 2| [TRDB MOGEQKM
Cutput MELT MULT

1| I [ [
Comment/Activate |

Remowve

Add...

Open...

Save as...

If the file ELMAM2.TXT is not in the working directory you need to specify the complete path. Note that in
a futur version of MoPro there may be a GUI checkbox to click in order to transfer the database to the actual
model. The transfer of the data base is for the moment not compatible with any refinement, so remove the
Refinement tab, and go the last molecular model by pressing 'next’ at the right of the molecular structure
file name. You do need to remove the Refinement tab, if you have a very recent version of the executable
of MoPro; for the Windows platform mopro-win32-1109.exe or later will do the job.




A MoProGUI for Windows %P o =] 4
ile Edit MoPro VMoPro MoProViewer Help
MoPro Input File x MoPro Output File ]
10pro.inp Files
Files
COptions
Qutput [¥] Molecular structure | gz1_0Z.par " Browse... | Edit < previous
Manual Commands next >
] Reflections hki | btk | srowse.. |
[] Bulk sohvent Fhikl | " Browse... ‘
[¥] Atomic Table |C\dlﬁracs\MquSu\lej1I]T\L|thFm\mupmlab " Browse... | Edit | Apply ‘
[¥] Wave Functions | CodiffracsiMoPraSuite_11071LibMaP rotWWAVEF || Browse... | Edit | Apply ‘
[ ———
Ci ivate asLKissel|C T unejWD?\L\thPm\asLKlaseld" Browse...
Remove
Add... [¥] Constraints | COMNSTRAIN " Browse... | Edit ‘
Open...
Save as.. [ Restraints | | srowse.. | Eat |

Run MoPro and check whether the transfer has taken place (see below figure). There are some warn-
ings because we have asked to output a cif-file and MoPro cannot find any variance-covariance matrix to
calculate standard deviations.
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Gle Edit MoPro VMoPro MoProViewer Help

MoPro Input File MoPro Output File X

projects’recipros
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I I [
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Kill MoPro s i

Now go in the MoPro Input File to the last molecular file (gz1_03.par) and add again a refinement tab.
We remain prudent and refine first only the scale factor for 5 cycles:
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/
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Save as...
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Run the refinement which should converge rapidly. Check then in the refinement tab the xyz coordinates,
the thermal parameters and exclude the hydrogens. Select the latest molecular file (gz1_04.par) in the Files

tab and run MoPro.

[MoProGUI for Windows XP - H:\projects'reciprocshaussoisigz_trf - 1ol x|
dle Edit MoPro VMoPro MoProViewer Help
MoPro Input File MoPro Output File x
10pro.out ) =
FILE PARA gzt _n4") |Tpplying : NEUT MULT =
FILE DATA gz1.hkl
FILE TABL Cdiffrg
FILE WAVE C idifl WEUTRALIZE ELECTRICALLY
E:i EEON"Q Emg MULT: neucralize molecule shift only charges of multipolar atoms
D TRy Tumber of atoms selected 3 /35
HKLITFORMAT (3] .
SELE SO0AXYZ UL Tumber of valence electrons, initially 105.35798
o REFILS & Mumber of valence electrons, group neutralized :  106.00000
WRIT CIF Average populacion shift applied to each atom :  +0.00120 I
WRIT FOUR
FILE BASE ELMA!
TRDB MOGEOM | 5|7 ———-— = End of MoPro job : 20/03/2011 12:59:33
MEUTMULT [ o Total CPU time needed : 0win  1.2968 5
--- Writing new output file : mopro_00S.out
Last molecular file : gzl_05.par
Check for 1 WARNINGS in 'mopro.out’ =
a Il I [
=
706
WwRIF
RI
wRal
et F
£of_Firee
1 » RF &
wRIF_fr
Scan mopro.out f 27204 12720
T — or 1 2 3 4 5
Kill MoPro w0 a 0 a 1 et

BMoPro Log

H: /projects/reciprocs/aussois/gz_trf mopro. inp
URZ(F) wax3hift/Simma Nobs

cycle loop
o5 3.7771
2/ 1.8056
3/ 1.7930
4/ 1.7980
5/ 1.7930

MoPro job finished

32.1165 1510
0.6547 1510
0.20768 1510
0.1010 1510
0.0500 1510

The refinement should give a large improvement with a final R-factor of 1.799. At this point you should
check the difference fourier maps and compare them with those after the Spherical Atom Model refinements.
Note that there are no supplementary refinement parameters compared to the earlier refinement. Try as well
to include the hydrogens in riding motion or using restraints or let them completely free. There are basically

10
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three ways to treat the hydrogens. You can use the CONSTRAIN file in the file tab, but then you can not
refine the positions since the protons are reset to the geometry specified in the CONSTRAIN file; take care
to exclude the refinement of the protons in the Refinement tab. Aternatively you can use the RESTRAIN file
- deselect the CONSTRALIN file - and then you should include the protons for refinement in the Refinement
tab. Or you use a partial or complete free refinement of the protons. For a complete free refinement
you remove the RESTRAIN and CONSTRAIN file from the File tab. It may be better to leave the isotropic
atomic displacement parameters for the protons restrained to the equivalent atomic displacement parameters
of the parent atoms. To do this, if you have already created a RESTRAIN file, you can edit it by pressing
"Edit’ on the File tab. It will open in a new tab and you delete all lines not related to PREP REST URAT
(see below figure).

B MoProGUI for Windows XP - H:projects\reciprocs’at =101 x|
Ele Edit MoPro VMoPro MoProViewer Help

MoPro Input File MoPro Output Fite 53 RSN ORH

! PREP REST UFAT =
URATIO  c1
URATIO 2
URATIO 3
URATIO  C4
URATIO €5
URATIO  CE
URATIO  C6
URATIO  CB
URATIO  C8
URATIO €11

URATIO  C1Z
URATIO N1
URATIO 02
URATIO 03
URATIO 04
URATIO 06

PREP REST 5IMANG
SIMygG 06 1 ¢6 1 HEA 1 06 1 @6 1 HEB 1 0.2
SIMAMWMGCS 1 C6 1 HEA 1 C5 1 C6 1 HEB 1 0.2
SIMANG 1¢81H8 1¢81¢E 1HE10.2
SIMANG C1 €91 H9 1C8 1c91EHY 1O,
sSIMANG c10 1%l 1 HI1 1 ci2 1 cil 1 10.2

o
o
2

Il

SIMANG ¢7 1 L HI1Z 1 €11 1 €12 2 10.2
SIMANG €1 1 N1 1 1c71m 1N 102

! PREP REST DIST
DISTAN €1 1 1 1,099 0.002
DISTAN 2 1 2 1 1.089 0.002
DISTAN 3 1 1.099 0.002
DISTAN  C4 HA 1.089 0.00%
DISTAN €5 1 1.099 0.002
DISTAN  C6 1 1.092 0.002
DISTAN 1 052 0.002
DISTAN 8 1 1. 0.002

1

1

1

5

DIST cg 1.08 0. 002
DI N 11
STAN cl2
Quit Refresh (F5) Save (CtrlsS) Save As... Search...(Ctrl+F)

1.083 0z
1.083 0. -

&
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